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Instruction Sheet 1      Learning Guide # 26 

This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics – 

 Creating and Naming Directories and subdirectories   

 Identifying Attributes of directories   

 moving Subdirectories between directories   

 Renaming Directories  

 Accessing Directories and subdirectories via different paths 

This guide will also assist you to attain the learning outcome stated in the cover page. 

Specifically, upon completion of this Learning Guide, you will be able to – 

 Create and name directories and subdirectories 

 Identify attributes of directories  

 Move subdirectories between directories 

 Rename directories as required  

 Access directories and subdirectories via different paths  

Learning Instructions:  

1. Read the specific objectives of this Learning Guide.  

2. Follow the instructions described below 3 to 6.  

3. Read the information written in the information ―Sheet 1, Sheet 2, Sheet 3, Sheet 

4 and Sheet 5‖ in page -3, 8, 12,18 and 18 respectively. 

4. Accomplish the ―Self-check 1, Self-check 2, Self-check 3, Self-check 4 and Self-

check 5‖ in page -7, 11, 14,17 and 21 respectively.  

5. If you earned a satisfactory evaluation from the ―Self-check‖ proceed to 

Operation ―Sheet 1, Sheet 2, Sheet 3 and Sheet 4‖ in page -22,23,24 and 25 

respectively. 

6. Do the ―LAP test‖ in page – 26 (if you are ready).  

 Your teacher will evaluate your output either satisfactory or unsatisfactory. If 

unsatisfactory, your teacher shall advice you on additional work. But if satisfactory you 

can proceed to the next topic.
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Information Sheet 1 Creating and Naming Directories and subdirectories   

1.1. How data is typically stored on a computer 

Data files such as word documents can be kept on a computer for future uses such as 

editing and printing. To find documents you will need to store them in an organised 

fashion—in the same way you might file documents like lesson notes, bills, letters and 

bank statements at home. 

Just as you might use folders to organise your personal or business documents, you 

also store your computer documents in folders. A folder is only a device for grouping 

files in the same location, not a data file.  

Folders and files can be stored on a computer‘s desktop or on a storage device which 

will be able to store hundreds or thousands of documents.  

Folders can be created or moved so that they sit within another folder, and so on. Other 

terms for describing this structure of files and folders grouped within folders are 

directory and sub-directory. 

You will need to decide where you want to save files. There are several types of 

storage devices that may be an option for you, depending on your computer setup. 

1.2. Storage devices 

 Hard disk drive (HDD) 

Your computer will have a hard disk drive. The hard disk drive is in the system 

unit. The hard drive is where the operating system and application programs are 

kept. If you are using a Microsoft Windows operating system, there is also a 

location called My Documents on the hard drive for storing your data files. You 

can also have a removable hard disk drive which has the advantage of being 

able to store a large amount of data and be transported and connected to other 

computers. 

 Floppy disk drive (FDD) 

A floppy disk is the least expensive storage media. They don‘t hold a lot of data 

but they are easily transportable. They can be damaged by smoke, heat, 

magnets and liquid. 
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 Memory stick/flash drive/thumb drive/pen drive/USB drive 

All these terms refer to a small drive that you plug into a USB port (an input connection 

on the system unit). They are small (about the size of a disposable lighter) and can be 

carried easily. They hold more data than a floppy disk. 

 CDs (compact disk) 

 CD-R: (compact disk read-only) are read-only format which means you can read 

the data but you can‘t write (add) data to the CD. They often have application 

programs or music stored on them. 

 CD-RW: (compact disk read-write) another form of CD that you can read and 

write to. This means you can add or copy data to this type of CD. You will need a 

CD burner to do this. 

1.3. Arranging icons 

 The icons on the desktop can be arranged so it is easy to find them. This is a good way to 

group programs together that you use a lot. 

 The long way to do this is to drag each icon with the mouse to a place on the desktop. 

A quicker way to arrange icons is to let the computer do it for you. 

 Arranging icons on the desktop 

Follow these steps to arrange the icons on the desktop:  

 

1 Go to the desktop. 

2 Right click an empty space on the desktop. A shortcut menu will appear. 

3 Select Arrange Icons from the shortcut menu.  

4  Click on by Name. 

5 The icons will arrange themselves neatly in alphabetical (A-Z) order. You can also 

arrange them by type, size or date. 

 Icons such as My Computer and the Recycle Bin never change their position when you 

choose this command. You can only move them around by dragging them with the 

mouse. 

1.4. Using desktop shortcuts 

 Some of the icons are automatically placed on the desktop when Windows is installed. You 

can also create shortcuts. Shortcuts are icons that represent files, folders or programs. They 

are really only a link to the real file or program. In other words, they are like a nickname that 

stands for a person's real name. 
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 All shortcuts have a little arrow in the lower-left corner of the icon. This indicates that the 

icon is a shortcut. 

 Any file, folder or program on your computer can be a shortcut. They do not use up much 

room on your hard disk. 

 It is a good idea only to make useful shortcuts. They should be used for the files or 

programs that you regularly use. 

Drive contains three folders under My Documents:  

1. Customers 

2. Staff 

3. Warehouse. 

The Customers folder has four sub-folders:  

1. CD Basement 

2. Gig Shop 

3. MP3 to go 

4. Music Beat. 

You can set up your own directory and sub-directories by creating new folders within a 

hierarchical structure, depending on a logical or business system for organising the 

directory. 

In our earlier example (Figures 1 and 2) the directory on the floppy disk has this 

hierarchical structure: 
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1.5. Creating a new folder: 
1. Locate the directory or folder in which you want to create a new sub-

directory/folder. 

2. Double-click on this folder to open it.  

3. In the folder window click on the File menu and select New then Folder. This 

creates a new (empty) folder inside the folder you have opened. 

4. Type in the name of the new folder (to replace the default text ‗New Folder‘.) 

 

To create more folders at the same level as this, keep selecting New Folder until you 

have all the folders you need. To create one or more folders inside one of the new 

folders, repeat the above steps. 

In this way you can create a hierarchy of folders according to a hierarchical structure. 

The new directory will be set up and ready to save or copy any documents into. In other 

ways You can create folders from: 

 the desktop (right click the mouse, choose new, then folder) 

 My Documents or 

 Microsoft Word 

In My Documents the main heading is called a directory. The sub-folders are called 

sub-directories. 

Follow these steps to create a new folder:  

1. Open My Documents 

2. Click on File in the top toolbar  

3. Scroll down to New on the menu 

4. Click on Folder from the sub-menu 

5. Give the folder a name 
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Self-Check -1 

 

Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in 

the next page: 

 

1. All refers to a drive that you plug into USB port except for one. 

A.  flash drive   C.  Pen drive 

B.  CD   drive          D.  Hard drive 

2. The type of CD that has read-only format which means you can read the data but you 

can‘t write (Add) data to the CD. 

A. CD-RW    C.  CD-W 

B. CD-WR   D.  CD-R   

3. The type of CD that you can read and write to, which means that you can add or copy 

data to this type of CD. 

A. CD-RW    C.  CD-W 

B. CD-WR   D.  CD-R   

 

 

 

 

Answer Sheet 

 

 

 

Name:  _________________________             Date:  _______________ 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  
You can ask you teacher for the copy of the correct answers. 
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Information Sheet 2 Identifying Attributes of Directories   

 

2.1. Attributes of Directories 

Sometimes you will need to check the attributes of a file or folder to ensure you use it 

appropriately. Or you may wish to set attributes to read-only so that data is not lost or 

changed by someone. 

Attributes define the type of file or directory which could be: 

 read-only  

 hidden  

 archive  

 system. 

2.1.1. To check or change the attributes of a file: 

1.  Double-click on My Computer on the desktop. 

2.  Double-click on a data drive and find a document file. 

3.  Right-click on the file you want to check. 

4.  Select Properties from the menu. 

 

Figure 4: The Properties box for this file 

shows that the file is Read-only. 

 

Under the General tab of the Properties box 

you can check or uncheck the boxes for read-

only or hidden. More attributes are under the 

Advanced button. 

Click OK to save any change to the attributes 

and close the Properties box. 
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2.2. The folder view 

There are many different ways you can display your electronic `filing cabinet' to view your 

files and folders. Some people prefer to see their folders and files listed while others 

prefer to have them displayed as icons. 

Changing the folder view 

Follow these steps to change the folder view.  

1.  Open Windows Explorer 

2.  Select View from the toolbar 

3.  Select how you want your files and folders displayed, e.g. Details 

 You can display files or folders as:  

 icons 

 titles 

 lists 

 details 

2.3. Icons 

The Icons view shows each folder and file as a large icon with its name underneath. If 

you have a lot of folders and files it is difficult to see them all at one time in this view 

because the large icons take up a lot of space. 

List 

The List view is where the files and folders are arranged in columns. You need to use the 

bottom scroll bar or left and right Arrow keys to see all of them. 

Details 

The Details view presents the file system as a list with details about the files and folders. 

These details include the name of file in alphabetical order (A-Z), the size of file, the 

type of file (i.e. Word document, spreadsheet, graphic document) and date and time 

when it was modified, that is, created and/or changed. 

2.4. Changing the view of all folders 

The view options you select only apply to the open folder. If you want to change the view 

of all folders, you must use the Folder Options dialog box. 
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Follow these steps to change the display of all folders and files in the same way: 

1. Open My Documents 

2. Click on Tools on the top toolbar 

3. Click on Folder Options. A dialog box will appear like the one below 

4. Select View 

5. Select the settings you want  

6. Click on “Apply to all Folders” 

7. Click on OK 

2.5. Folder properties 

A folder's 'properties' refers to information about: 

 its type 

 its location 

 its size 

 the number of files and other folders it contains 

 when it was created 

Information about the size of a folder is useful if you need to save the folder on to a floppy 

disk and want to know if it will fit.   
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Self-Check -2 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in 

the next page: 

 

The _______ view shows each folder and file as a large icon with its name underneath.  

A. Icons 

B. List 

C. Details 

D. All 

The __________ view is where the files and folders are arranged in columns. 

A. Icons 

B. List 

C. Details 

D. All 

The ______ view presents the file system as a list with details about the files and folders. 

A. Icons 

B. List 

C. Details 

D. All 

 

 

Answer Sheet 

 

 

 

Name:  _________________________             Date:  _______________ 

 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  
You can ask you teacher for the copy of the correct answers. 
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3.1. Working with folders 

Folders are a way of organizing your files so that it is easy to find them. This is similar to a 

paper filing system. In a paper filing system documents are organized into folders that 

describe what is in them. For instance, a folder called Power Bills will include gas and 

electricity bills and payments. A folder called Stationery would contain stationery orders, 

bills and catalogues. It is important to give files and folders names that you and other 

members of staff can easily recognize.  

3.2. Renaming folders 

You will notice that there is a '+' (plus) or '-' (minus) sign next to the main folders or 

directories. The `+' sign indicates there are sub-folders (sub-directories) within this folder.  

When the folder has a minus sign beside it, it means that all the sub-folders within the 

folder are on view. 

You can rename a folder in the same way that you rename a file. 

Follow these steps to rename a folder: 

1. Open My Documents 

2. Find the folder you want to rename and right click on it 

3. Select Rename from the shortcut menu that appears 

4. Type the new name on top of the old name. As you type, the old name will  

3.3. Deleting folders 

The steps for deleting a folder are the same as for renaming a folder but you 

select Delete rather than Rename from the shortcut menu above. 

Follow these steps to delete a folder: 

1. Open My Documents 

2. Find the folder you want to delete and right click on it  

3. Select Delete from the shortcut menu that appears 

Information Sheet 3 Renaming Directories 
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Rename directories 

You can rename your folders at any time. To do this: 

1.  Right-click on a folder. 

2.  Left-click on Rename in the menu. 

3.  Type in the new folder name. 

4.  Press Enter on the keyboard to save the change.
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Self-Check -3 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in 

the next page: 

1 Which way do you find easier to view the folders and files?  Why? 

 

 

2 Right click on a folder in My Documents and select Properties.  List three bits of 

information that comes up. 

 

 

 

3 Why is there a `+' (plus) symbol next to some folders? 

 

 

 

 

 

 

 

 

 

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  
You can ask you teacher for the copy of the correct answers. 
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Information Sheet 4 Moving Subdirectories between directories   

 

4.1.  Move subdirectories between directories 

Sometimes it is necessary to move a folder to another location or folder. Here are two 

ways you can do this. (Note that you can move a file in the same ways.) 

4.1.1. Use „Move to Folder‟ 

1. In window view, click once on the folder you want to move (so that it is selected). 

2. In the window‘s Toolbar click on the Edit menu and select Move to Folder. 

3. Select the folder you want to move the selected folder to. To do this, scroll up or 

down the list to find the target folder. You may also need to expand folders to find 

the folder you want. To select the target folder, click on the folder name so that it 

is highlighted. 

4. Click on the Move button. 

           Follow these steps to move a folder: 

 1. Open My Documents 

 2. Right click on the folder you want to move 

 3. Click on Cut in the shortcut menu that appears 

 4. Find the new folder you want to move your new folder into 

 5. Right click on an empty space in the new folder 

 6. Click on Paste from the shortcut menu that appears. The moved folder then 

becomes a sub-folder of the new folder. 

You can also move folders using the mouse. To do this put the mouse on a folder name, 

left click the mouse button and keep it pressed down while moving the folder to a new 

spot. You release the mouse when you are in the right spot.  
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4.1.2. Drag the folder to the new location 

Another way to move a folder is to drag the folder to the new location: 

 Click on the folder icon and keep the mouse button down as you drag the folder 

over the top of the target folder. Release the mouse button when the target folder 

is highlighted. OR 

 Click-drag the folder into the window area of an open folder or drive window. 

Follow these steps to drag a file to a new folder: 

1. Go to My Documents 

2. Find the correct folder and click on it to open it  

3. Find the file you want and click on it  

4. Attach the mouse pointer to the file 

5. Use the left mouse button to drag and drop the file into the new folder  
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Self-Check -4 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in 

the next page: 

Fill the Blank space 

1. Make the structure of files and folders grouped within folders. __________ 
 
2. It is a device for grouping files in the same location, not a data file. _______ 
 
3. It is where the operating system and application programs are kept? __________ 
 

 

 

 

 

 

 

 

 

 

Answer Sheet 

 

 

 

Name:  _________________________             Date:  _______________ 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  
You can ask you teacher for the copy of the correct answers. 
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Information Sheet 5 Accessing Directories and subdirectories via different paths 

 

1.1. Access directories on your computer 

You can view folders on a drive and the contents of the folders through windows. 

Double-clicking on a drive icon or a folder icon opens a window which shows you its 

contents. 

Access directories and sub-directories 

Figure 1 shows a view of the directories and sub-directories (folders) that are stored on 

a floppy disk. 
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Figure 1: When the Customers folder is selected in the left frame its sub-folders 

are listed in the right frame 

 

 

Figure 2: One folder and three files are contained in this folder 

1.2. Change the view of a folder‟s contents 

You can choose a different view (appearance) of the contents of a folder depending on 

what is useful for you. 

 

 

1.  Click on the View menu of a window. 

2.  Select a view from the menu (Thumbnails, Icons, List, Details). 

Try each of these to see the different views. 
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1.3. View a directory tree structure 

Files and folders can be enclosed by any number of folders which creates a hierarchy or 

tree structure. You can change the view of a folder window to see the directory tree 

structure. This allows you to see the whole directory structure as well as the contents of 

any folder in one view.  

An easy way to view the directory tree is to click on the Folders button on a window 

Toolbar (see the window Toolbar in Figure 2). If you can‘t see the Folders button on 

the Toolbar, click-drag the right edge of the window to expand the size of the window 

and its Toolbar.  

When you click on the Folders button the directory tree will appear in the frame on the 

left. When you click on a folder its contents are listed in the right frame (see Figure 1 

and Figure 3). 

 

Figure 3: The folder CD Basement is selected in the left frame so that its contents can 

be viewed in the right frame 

In the left frame you can click on the arrow sign next to a folder to expand the folder—

this will also show you the contents of the folder (listed in the left frame) under the 

folder. Click on the - sign next to a folder to contract the folder (to hide the contents of 

the folder). 

To change the window view back to the original view, click on the Folders button again.
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Self-Check -5 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in 

the next page: 

Say true if the statement is correct, else False 

1. _______ are the structure of files and folders grouped within folders. 
A. Directories 

B. Folder 

C. Files and folders 

D. All 

2. _______ is a device for grouping files in the same location, not a data file. 
A. Directories 

B. Folder 

C. Files and folders 

D. All        

3. _____ can be enclosed by any number of folders which creates a hierarchy or 
tree structure.  
 

A. Directories 

B. Folder 

C. Files and folders 

D. All 

 
 

 

Answer Sheet 

 

 

 

Name:  _________________________             Date:  _______________ 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  
You can ask you teacher for the copy of the correct answers. 
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Operation  Sheet 1 Creating and Naming Directories and subdirectories   

 

Task 1: Follow these steps to arrange the icons on the desktop:  

 

1. Go to the desktop. 

2. Right click an empty space on the desktop. A shortcut menu will appear. 

3. Select Arrange Icons from the shortcut menu.  

4.  Click on by Name. 

5. The icons will arrange themselves neatly in alphabetical (A-Z) order. You can also 

arrange them by type, size or date. 

Task 2:  Follow these steps to create a new folder:  

1. Open My Documents 

2. Click on File in the top toolbar  

3. Scroll down to New on the menu 

4. Click on Folder from the sub-menu 

5. Give the folder a name 
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Operation  Sheet 2 Identifying Attributes of Directories   

 

Task 1: To check or change the attributes of a file: 

1.  Double-click on My Computer on the desktop. 

2.  Double-click on a data drive and find a document file. 

3.  Right-click on the file you want to check. 

4.  Select Properties from the menu. 

Task 2: Follow these steps to change the folder view.  

1.  Open Windows Explorer 

2.  Select View from the toolbar 

3.  Select how you want your files and folders displayed, e.g. Details 

Task 3: Follow these steps to change the display of all folders and files in the same way: 

1. Open My Documents 

2. Click on Tools on the top toolbar 

3. Click on Folder Options. A dialog box will appear like the one below 

4. Select View 

8. Select the settings you want  

9. Click on “Apply to all Folders” 

10. Click on OK 

11. Open My Documents 

12. Find the folder you want to rename and right click on it 

13. Select Rename from the shortcut menu that appears 

14. Type the new name on top of the old name. As you type, the old name will  
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Task 1:  Follow these steps to delete a folder: 

1. Open My Documents 

2. Find the folder you want to delete and right click on it  

3. Select Delete from the shortcut menu that appears 

Task 2: Rename directories 

You can rename your folders at any time. To do this: 

1.  Right-click on a folder. 

2.  Left-click on Rename in the menu. 

3.  Type in the new folder name. 

4.  Press Enter on the keyboard to save the change. 
 

Information Sheet 3 Renaming Directories 
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Information Sheet 4 Moving Subdirectories between directories   

 

Task 1: Follow these steps to move a folder: 

1. Open My Documents 

2. Right click on the folder you want to move 

3. Click on Cut in the shortcut menu that appears 

4. Find the new folder you want to move your new folder into 

5. Right click on an empty space in the new folder 

6. Click on Paste from the shortcut menu that appears. The moved folder then 

becomes a sub-folder of the new folder. 

 

Task 2:  Follow these steps to drag a file to a new folder: 

1. Go to My Documents 

2. Find the correct folder and click on it to open it  

3. Find the file you want and click on it  

4. Attach the mouse pointer to the file 

5. Use the left mouse button to drag and drop the file into the new folder  
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Lap Test Practical Demonstration 

 

Name:  _____________________________   Date:  ________________ 

Time started: ________________________  Time finished:  ________________ 

Instructions: Given necessary templates, tools and materials you are required to 

perform the following tasks within --- hour. 

Task 1: Create and name directories and subdirectories 

1.  Create the following three directories in a folder called ‗My 
Documents‘: 

1. Customers 

2. Staff 

3. Warehouse 

2.  Create the following four sub-directories within the Customers 
sub-directory: 

1. CD Basement 

2. Gig Shop 

3. MP3 to go 

4. Music Beat 

3. Create the following three sub-directories within the Staff sub-
directory: 

4. Overtime 

5. Rosters 

6. Timesheets 

4.  Create one sub-directory within the Warehouse sub-directory: 

1. Utilities 

 

 Your teacher will evaluate your output either satisfactory or unsatisfactory. If 

unsatisfactory, your trainer shall advice you on additional work. But if 

satisfactory, you can proceed to the next topic. 
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4. Fundamentals of Computing 

5. Introduction to computer  

6. TTLM or modules and journal of ICT 
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8. Good Practice in Occupational Health Services by WHO  
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